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LIST OF ACRONYMS AND ABBREVIATIONS
Provide if thesis contains six or more acronyms and/or abbreviations. The preferred format is to capitalize proper nouns but lowercase common nouns; above all: be consistent. For capitalization guidance on many acronyms used in the Department of Defense, refer to the Department of Defense Dictionary of Military and Associated Terms.
Compile the list in alphabetical order by acronym/abbreviation, with numbered terms preceding lettered terms, as shown. 

2LM 	Role 2 light maneuver
APOE 	aerial port of embarkation
BHR 	Bureau of Humanitarian Response
JLOC 	joint logistics operations center
MILOB 	military observer
NATO 	North Atlantic Treaty Organization
RFID 	radio frequency identification
SOFAR 	sound fixing and ranging
TLAM 	Tomahawk land attack missile
TGIF	thank goodness it’s Friday
VA 	Veterans Administration
WORM 	write once read many
ZULU 	time zone indicator for Universal Time
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Executive summary
This is NOT your abstract. Your abstract must be entered into your thesis dashboard in Python, and it will output as part of your First 8 Pages file.
An executive summary is required or recommended for the departments listed in our “Abstracts versus Executive Summaries” guidance document found here and on the “Resources” page of our website. Please consult your advisors for guidance regarding length, content order, and style. Most executive summaries range from 2–5 pages (500–1,250 words). 
An executive summary is a highly condensed version of your thesis that should be able to stand alone, independent of your thesis. An executive summary should summarize your purpose, methods, results, conclusions, and recommendations to allow someone who can read ONLY that document to walk away with a solid understanding of the overall purpose, scope, methods, and findings of the research. Some departments require inclusion of policy recommendations. 
If you include figures or tables in your executive summary, do not apply our figure or table styles to the titles. Instead, use Normal style and manually format the titles to match the titles in the body of the thesis. This will keep these titles out of your thesis’s Lists of Figures and List of Tables, and allow the figure and table numbering to start at “1” in the main thesis body, as required.
If you include citations in the Executive Summary, include a separate reference list at the bottom of the last page of the summary. If using Chicago Notes and Bibliography, see additional guidance on the following page.

References
If you are not using Chicago Notes and Bibliography as your citation style, include a separate reference list for the Executive Summary here.

If you are using Chicago Notes and Bibliography, use traditional footnotes in lieu of a reference list, and restart the footnotes at “1” in the main thesis body.
To ensure the first footnote in the body of your thesis restarts at footnote 1, right click on the first footnote (in the footnotes section, not in the body of your thesis) > Note Options > Numbering: Restart each section.
When you update the footnotes in the body of your text to begin at “1,” you may see a continuous section break where footnote 1 appears. This section break needs to be removed. To see what’s going on behind the scenes, make sure the Show/Hide button is on in the Home tab). See Figure 1. 
[image: A screenshot of a computer
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Notice this figure number is typed in manually (no style applied), so that the figure numbering begins at “1” in the main thesis body, as required, and this figure does not appear in the List of Figures.
Figure 1. The Show/Hide button. 

If you still don’t see the section break, place your cursor directly in front of the footnote and hit “enter” to add a paragraph mark, then select both the paragraph mark and section break (Figure 2). Delete the highlighted text. Please contact our office with any questions.
[image: A close-up of text
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Figure 2. Section Break


ACKNOWLEDGMENTS
Optional for all departments. Acknowledgments may be more informal in tone than the main thesis text but should still follow the correct use of sentence structure, grammar, and punctuation. 
Write your own acknowledgments; do not borrow the text from another author. While acknowledgments tend to be similar across document types, they should reflect your own language.
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[bookmark: _Ref113613024][bookmark: _Ref113613034][bookmark: _Toc155786289]USING THE TEMPLATE
Review the next few pages before you start working in this template. Chapter II contains more detailed instructions for formatting.
[bookmark: _Toc155786290]FIRST THINGS FIRST
Before you begin formatting your thesis:
Always download a new template; old, borrowed templates corrupt over time. 
Use the desktop application for Microsoft Word, not an online/browser version; working online will destroy your formatting.
Download and follow the Template Setup instructions. 
[bookmark: _Toc155786291]APPLYING STYLES
The most commonly used styles to apply to your thesis are shown in Figure 1 and Table 1. Do not modify styles. For help, contact your thesis processor or email us. 
[image: ]
Heading 1, Heading 2, and Heading 3 pull to the Table of Contents. Tell Word to update the lists by right-clicking on each and choosing Update Field.
[bookmark: _Toc155786314]Heading Styles
[bookmark: _Toc155786324]The Styles and Their Uses
	For this …
	Use this style …

	A regular paragraph
	All Paragraph

	Heading 1 (chapter heading)
	Heading 1

	Heading 2 (subheading)
	Heading 2

	Heading 3 (subsubheading)
	Heading 3

	A figure
	Image

	An image
	Image

	A picture
	Image

	A table (that you are creating)
	Use Word’s InsertTable function

	A table (copied from another document)
	Normal, then center it

	Figure title/caption 
	Figure Title

	Figure subcaption (not the main title)
	Figure Secondary Title

	Table title
	Table Title

	Table note (for below the table)
	Table Note

	Block quote
	Block Quote

	Bulleted list (not a direct quote)
	List Bullet

	Bulleted list (if a direct quote)
	Block Quote for Bulleted List

	Numbered list (not a direct quote)
	List Number

	Numbered list (if a direct quote)
	Block Quote for Numbered List

	Heading 4 (subheading below Heading 3)
	Heading 4

	Heading 5 (subheading below Heading 4)
	Heading 5

	A set of numbered paragraphs
	Heading 5




[bookmark: _Toc155786292]PASTING INTO THE TEMPLATE
Reformatting after pasting text from another file is usually needed because the NPS formatting specifications are different from Word’s default specifications. Therefore, when you transfer text from another file into this template, some loss of formatting from your other file may occur. This is usually minor.
[bookmark: _Toc155786293]TABLE OF CONTENTS, LIST OF FIGURES, LIST OF TABLES
DO NOT manually update the Table of Contents, List of Figures, or List of Tables. After styling all headings, figure titles, and table titles, right-click in each list to update (text field turns gray). Click the “Update entire table” option as shown in Figure 2. More details are provided here.
[image: ]
[bookmark: _Toc155786315]Final Step When Updating Table of Contents, List of Figures, or List of Tables
THIS PAGE INTENTIONALLY LEFT BLANK
[bookmark: _Toc155786294]FORMATTING (THIS IS A HEADING 1)
If you encounter any problems when formatting your paper, please contact your thesis processor. If you do not yet have a thesis processor, please email us, and we will be glad to help. Do not attempt to alter styles yourself.   
[bookmark: _Toc155786295]FORMATTING IN A NUTSHELL (THIS IS A HEADING 2)
Formatting your thesis is simply the act of clicking on a “style” button to format a piece of content—paragraphs, headings, block quotes, captions, and the like. Figure 3 breaks down the process. Locating the styles is covered next.
[image: ]
[bookmark: _Toc155786316]Basic Formatting Steps
[bookmark: _Toc155786296]TEMPLATE SETUP
The template contains the pages and styles needed to format your paper. Follow these steps to get started.
Download and save template. If “Maintain Compatibility with Previous Versions of Word” prompt is available, checkmark it. Always download your template. Working online will destroy your formatting.
Open the template.
Configure your Microsoft Word settings per our Template Setup handout.
[image: ]On the Home tab, click the Show/Hide button (     ) to see all formatting marks.
On the Home tab, in the Styles pane, click the small arrow on the bottom-right corner of the pane to open the full list. You can also access the NPS template styles from the Styles pane. (Mac users, see the  Template Setup handout.)
[bookmark: _Toc155786297]PASTING INTO THE TEMPLATE
Reformatting after pasting text from another file is usually needed because the NPS formatting specifications are different from Word’s default specifications, and letter and word spacing varies among the different versions of Word. Therefore, when you transfer text from another file into this template, some loss of formatting from your other file may occur. This is usually minor. Here are some best practices for pasting text into the template:
Styles: Remove formatting from your text before pasting it in. To remove formatting, highlight the text, and from the Styles pane, choose Clear All (usually the first option). After pasting into this template, immediately apply the desired style—
Heading 1, Figure Title, Block Quote, List Bullet, etc. 
Paste options: If you prefer to paste in your entire thesis at once—and reformat everything afterward—Word will offer you several paste options. We recommend “Use Destination Theme” from the Paste menu. After pasting in your text, you are now ready to apply the NPS thesis styles. 
Figures: When pasting in text underneath a figure title, ensure the style in this template is set to All Paragraph first.
Footnote tips: If your thesis has substantial footnotes, and pasting in results in strange-looking formatting, in the non-template file, double-click into the footnotes and Select All (Control + A). Then, in the Styles pane, apply Normal style to them. Apply 10-point font size and Times Roman font. Then, copy and paste your text into the template. Once your text is in, double-click into the footnotes, select them all, and apply the Footnote Text style from the Styles pane. Doing this will visually “clean up” the formatting and help the format hold steady when you transfer from another file into this template.
Margins: After you paste in the first time, double-check that the margins in the template were retained (Layout > Margins > Office 2003 Default).
[bookmark: _Toc155786298]APPLYING HEADING STYLES
To each heading, apply the heading style (Heading 1, 2, 3, 4, or 5) that corresponds to the level in your outline (see Figure 4). When you apply each heading style, the proper letter or number will automatically appear, and formatting will be applied. Figure 4 shows how the heading styles display your thesis outline in the Table of Contents, once they are applied to thesis text. Use headings only to introduce a new section of thesis text. Place paragraph text under each heading before introducing the next level of heading. There must be at least two headings for each heading level (A and B, 1 and 2, a and b, at minimum), or do not use the heading.
Heading 3s and Heading 4s must be typed in uppercase and lowercase letters. Do not use Heading 3s to make a numbered list; use the List Number style or Heading 5 style to accomplish that task.
Heading 5 style typically is used for subsections below the Heading 4 level (see here).
[image: ]
When heading styles 1 to 3 are applied to text, they will appear in the Table of Contents.
[bookmark: _Toc155786317]Heading Levels and Their Styles. Adapted from Hawks (2015).
[bookmark: _Toc155786299]APPLYING BODY TEXT STYLES
To all paragraphs in the document, apply All Paragraph style. Styles for other elements in a thesis—such as  block quotes, equations, and bulleted lists—are discussed in the following sections. 
[bookmark: _Toc155786300]Figures (This Is a Heading 3)
Formatting for figures in NPS theses may be different from what you are used to doing; therefore, please read and follow these instructions carefully. The commonly used format is shown in Figure 5. Figures 6 through 10 show accepted variations of the commonly used format.
 [image: ]Crop excessive white space 
from images.
Figure Title style. If you choose to use sentence case (not shown), do so for all Figure Titles. 


[bookmark: _Toc155786318]A Basic Figure 
Figures should be styled as Image style. This centers the image and applies even white space. 
Insert figures between sentences or paragraphs after they are cited in the text. Never place figures in the middle of a sentence or paragraph.
Titles should not be included in the image since they will be written in the figure’s caption, hereafter called a “figure title.” If a borrowed figure contains a title inside it, your figure title must be different.
Figures should be readable if the words in them are meant to be read. You may need to re-create images when the source text is too fuzzy to read. Or, you may need to enlarge the image and place it on a horizontal page. Do this by inserting a “Continuous Section Break” at the start and end of your horizontally aligned information and changing the page orientation to “landscape.” Section breaks are available in Word’s Layout tab. After you landscape the page, you may need to adjust the page numbers: Double-click into the footer > Header & Footer tab appears in the Ribbon > click Page Number > Format Page Numbers > Continue from previous section.
Each figure must be referred to by its number in the body text prior to displaying the figure. Refer, for example, to Figure 23, without including its title or page number. 
The meaning of figures must be clear enough so that they can stand alone.
Directions should not be used to refer to figures. In your text, do not use descriptive words such as “above” or “below” when referring to figures.
Please convert MS Office Graphic Objects or HTML format into images; otherwise, there is a risk of them dropping out at the PDF conversion stage. Here’s how to convert them: click on the figure to select it > then Cut > Paste Special > choose PNG format or Enhanced Metafile. Ensure that there is a paragraph return after the figure and before the figure title. Apply Image style to the new image for correct formatting.
[bookmark: _Figure_Titles_(This]Figure Titles (This Is a Heading 4)
Each figure must have a title. Type the title outside of the actual figure. Follow these NPS thesis style guidelines for figure titles, which, in some disciplines, are referred to as captions: 
Type your figure title below the figure itself, as shown in Figure 6.
Use a short, definitive title that tells your reader the main topic and the main takeaway from your image.
Try to limit your title to fewer than 12 words, since these will appear in your List of Figures. 
Use sentence fragments, not complete sentences. 
Use either title case or sentence case—just be consistent with all your figure titles. If you use title case, capitalize all words except prepositions, articles, and conjunctions. If you use sentence case, capitalize the first word, any proper nouns, and any word after a colon.
Do not end a figure title with a period, unless the title is followed by a citation; adding citations to figure titles is covered next in Section b.
Once you have your title typed in, apply Figure Title style to the title. Word automatically inserts the word “Figure,” a sequential number, and a tab space for you, as shown previously in Figure 5.
Figure Citations
A citation is required if you did not wholly create the image or information yourself; placement of the citation is shown in Figure 6 (and in Figure 7, for students using Chicago Notes and Bibliography citation style). A citation is not needed when all elements of the figure are your own creation. 
For any figure that is not your original work, you must cite the source as part of the Figure Title, using the short-form citation for your chosen citation style. 
Place a period and space after the figure title but before the citation. 
If the figure is directly reproduced from a reference, use “Source: ___.” 
If you changed the original figure, use “Adapted from ___.” 
Chicago notes and bibliography users may use a footnote; see Figure 7.
When the source is a webpage, the URL alone is not sufficient; follow appropriate citation style.
If you need to provide a full citation, or your sources are numerous, place it in a “secondary caption” (covered next in Section c), not with the figure title. 
[image: ]Add any citations after the title, as a new sentence. 
Start citation with either “Source:” (exact image borrowed) or “Adapted from” (original was altered).
(IEEE users should use a reference number in brackets.)

[bookmark: _Toc155786319] A Figure with a Citation in APA and INFORMS Style. Source: Name (2017).
 [image: ]
[bookmark: _Toc155786320]A Figure Cited Using a Footnote in Chicago Notes and Bibliography Style.[footnoteRef:1] [1:  Chicago Notes and Bibliography users must precede footnotes used to cite figures or tables with either “Source:” or “Adapted from” as applicable, like this: Adapted from Morrison, Song of Solomon, 22.] 

[bookmark: _U.S._Copyright_Laws]U.S. Copyright Laws (This Is a Heading 5)
NPS students must comply with U.S. copyright law when using figures, illustrations, and images created by others. Those found in U.S. federal government documents are rarely copyrighted, but this should not be assumed.
You have several options when incorporating another person’s copyrighted work into your document: 1) obtain permission from the copyright owner, 2) follow item-specific licensing rights and restrictions, or 3) determine fair use, an exemption provided in U.S. copyright law for education and research. A determination of fair use must be made on an image-by-image basis, using a four-factor fair use checklist.  For more fair use guidance, visit the Dudley Knox Library’s Fair Use page. For more information on copyright issues, visit the Dudley Knox Library’s Copyright page.
Figure Secondary Caption, Separate from Figure Title (Optional)
Depending upon your discipline’s norms, you may need more than a summary figure title, whether to include justification for using the source, explain why certain data were presented and other data omitted, or provide more information about methodology used, for example. This additional information must be placed in a secondary caption. Refer to Figure 8 for an example of the format.
[image: ]A cross reference.
See Section H, “Cross Referencing”
Optional: Place any extra information directly below the figure, using Figure Secondary Caption style.


If you would like to provide more detail than what is in the figure title, provide it here, in a secondary caption. Apply Figure Secondary Caption style to secondary captions.
[bookmark: _Toc155786321]Placement of Optional Secondary Caption in Figure Title
You may add a secondary caption between the figure and the figure title:
Write secondary captions in complete sentences, not fragments, unless you are listing legend elements. 
Use sentence case (capitalize first word and proper nouns only).
Apply Figure Secondary Caption style to this secondary text by highlighting it and selecting the style from the Styles pane.
[bookmark: _Optional_Figure_Format:]Optional Figure Format: Multi-Line Figure Titles / Combining Figure Title and Secondary Caption
Depending upon your discipline’s norms, figure titles may be composed of more than one sentence to include justification for using the source, an explanation on why certain data was presented and other data omitted, or more information about methodology used. See Figure 9 for an example of a multi-line figure title. 

Create multi-line figure titles as follows: 
Use a sentence fragment, not a complete sentence, for the first sentence, which summarizes the primary point of the image.
If you are adding source information, place a period and space after the first sentence and then type the citation in its own sentence. 
Write all other (secondary) sentences in complete sentences, not fragments, unless you are listing legend elements. 
Use sentence case for all other sentences after the first and the citation.
Insert a “style separator” before secondary caption text. Get the instructions here. These secondary captions will remain in your text as a continuation of the figure title but will not appear in your List of Figures. 
[bookmark: _Ref431889327]Optional format: multi-line Figure Titles are also accepted, provided only the first line is visible in the List of Figures.

See Chapter II, Section E.1.d for format instructions.

 [image: ]
[bookmark: _Toc155786322]Variation—Multi-line Figure Title, with Only the First Sentence in the List of Figures.
Adapted from Doe (2017). You will need to insert a style separator after the figure title and before secondary text; instructions are provided in Section d. Use sentence case after the first line.

Optional Figure Format: Figure Title above Figure
You may elect to place all of your figure titles above your figures. In this case, place the more detailed secondary caption below the figure: 
Write secondary captions in complete sentences, not fragments, unless you are listing legend elements. 
Use sentence case.
Apply the Figure Secondary Caption style to this secondary text by clicking into it and selecting the style from the Styles pane.
Your thesis processor will adjust your Image, Figure Title, and Figure Secondary Caption styles to accommodate this optional format. Please do not attempt to do this yourself.
Refer to Figure 10 for an example of this format.
Optional format: 
You may place Figure Titles above your figure (but do so for all figures if you go this route). 


[bookmark: _Toc155786323]Variation—Figure Title above Figure
[image: ]
If you placed all of your figure titles above your figures, then place the secondary caption below the figure, as shown here. Your thesis processor will adjust the necessary styles during your Initial Review to accommodate this format. 

[bookmark: _Toc155786301]Tables
For tables, follow the NPS thesis style guidelines for figure titles, with these differences: 
Place table titles above the tables themselves, never below.
Apply Table Title style to each short, descriptive table title. The template will insert “Table” followed by the sequential number, a period, and a tab space before your descriptive title.
Notes or legends should be placed underneath the table and must be aligned with the left side of the table. Apply Table Notes style to these additional details. Then, in the View tab, check the Ruler box to see the ruler. Click on the square underneath the triangles to the left and drag the notes in place.
Use Normal style on the tables themselves, do not use Image style.
Place the citation, if any, after the table title, as its own sentence. 
See Table 2 for an example of where to place the citation.
If the table is directly reproduced from a reference, use “Source: ___.” 
If you have made changes to the original table or created a table using data from another source, use “Adapted from ___.” 
If you have numerous citations, place the citation in a table note. 


[bookmark: _Toc155786325]Figures and Tables Matrix. Source: [5].Table Note style. Align notes with left side of table. (In the View tab > Ruler > drag the square under the left triangles.) 

Tables must be no wider than paragraphs. Landscape the page if needed.

	
	Style to Use on Picture
	Style to Use on Title
	Placement of Title
	Style to Use
for Extra Information
	Placement 
of Extra Information

	FIGURE 

Preferred Formata
	Image
	Figure Title
	Below figure
	Figure Secondary Caption 
	Between figure and Figure Title

	FIGURE 

Optional Format
	Image
	Figure Title
	Below figure
	None—Figure Title 
is composed of multiple sentencesb
	N/A

	FIGURE 

Optional Format
	Image
	Figure Title
	Above figure
	Figure Secondary Caption
	Below figure

	TABLE
	NormalIf not using a Table Note, add a return (with 1.5 line spacing) under each table.

	Table Title
	Above table
	Table Note
	Below table


You many include notes or a legend underneath a table. Align them with the left side of the table.
a Pick one of the figure formats offered in this table and use it consistently throughout your thesis.
b See Chapter II, Section II.E.1.d for instructions on how to do multi-line figure titles.
[bookmark: _Toc155786302]Blank Pages
Your thesis processor will insert blank pages where needed during your final review. A page titled “This Page Intentionally Left Blank” will be inserted, as needed, to force a chapter to start on an odd-numbered page. This forces the first page of each chapter to open to the right side if the thesis is printed out.
[bookmark: _Toc155786303]Footnotes
Apply Footnote Text style to your footnotes:
1. Place cursor in footnote text. 
Select all footnotes (Control + A).
In the Styles pane, select Footnote Text.
[bookmark: _Toc155786304]Bulleted and Numbered Lists
Guidance for bulleted or numbered lists is as follows:
Apply List Bullet style to bulleted lists and List Number style to numbered lists. 
If your bulleted or numbered list is a direct quote from the original, apply Block Quote for Bulleted List or Block Quote for Numbered List styles.
Restart a numbered list at “1” by right-clicking on the first item and choose Restart at 1.
Avoid using a mixture of bullets icons for different lists in your thesis.
Use periods on bulleted and numbered lists only if the text consists of  complete sentences.
[bookmark: _Toc155786305]Block Quotes
Quotations of five or more lines are to be styled as Block Quote style, with no quotation marks around the quote. This signals that the material is quoted. For formatting purposes only, the quotation becomes a separate paragraph. Citations go outside the period (block quotes only).Don’t put quotation marks around block quotes!

Quotations are understood to be excerpts; therefore, ellipses are usually not used at the beginning of a quotation. Ellipses are used in the middle of a quotation where a portion of the text has been omitted. This is an example … of the correct use of ellipses. For quoted material within a block quote, use double quotation marks. Citations go outside the period for block quotes only, like this. (Naval Postgraduate School, 2017) 
To continue the paragraph visually as shown here (if desired), remove the paragraph indent from text following a block quotation (View tab > Ruler > Click on top of the triangle ruler guide and slide it to left margin).
Quoting a Bulleted List
Pretend this is a bulleted list that has been copied verbatim from a source. 
For such lists, use Block Quote for Bulleted List style for such quotes.
NPS has excellent guidelines on citing bulleted and numbered lists here.
Quoting a Numbered List
Pretend this is numbered list that has been copied verbatim from the source.
Format such numbered lists using Block Quote for Numbered List style. 
If you have multiple quoted numbered lists, you may need to restart each list at “1” by right clicking on a number and choosing “restart at 1.” If the margins jump after the adjustment, use the Decrease Indent button in Word’s Paragraph pane.
NPS has excellent guidelines on citing bulleted and numbered lists here.
[bookmark: _Toc155786306]Equations
PC users should use MathType to create equations, which you can download from the NPS Technology website. Note that MathType’s Microsoft 365 add-in does NOT have an equation numbering feature. Also, do not use the Insert > Equation option in Microsoft Word, because math symbols could disappear or morph when the file is converted to PDF. 
For Mac users running the Catalina operating system, MathType is not compatible as of this writing. See our “How do I create/number my equations?” here for ideas.
Do not clear coding from your thesis in one fell swoop by selecting all text and removing the code. Doing this will end up converting all of your equations to pictures.
The most popular format for equations is to center them and place the equation number on right margin (choose Right-numbered equation in MathType). Whether you number your equations is at your discretion.
	5x=10	(1)
If you created equations outside of MathType, or if you created equations in MathType without first numbering them but now want them numbered, follow these instructions:
1. Place your cursor in front of the equation, go to your style list, and choose either Equation or MTDisplayEquation. 
Then, press tab. Your equation should jump to center of the page. If it does not, remove extraneous space and tab markings. There should be only one tab space.
Place your cursor after the equation and press tab again. The cursor will jump to the right margin. 
Now click Insert Number on the MathType menu if you want MathType to number your equations (to format the numbers, click Insert Number). Or, you can manually number your equations. 
[bookmark: _UPDATING_THE_TABLE][bookmark: _Toc155786307]UPDATING THE TABLE OF CONTENTS
Do not manually type your own Table of Contents. After styling all headings in your thesis, right-click on the Table of Contents (text field turns gray). 
1. Select Update Field.
[image: ]

Then select Update entire table.
[image: ]

Each heading will appear in proper outline form.

A glance at the completed Table of Contents should provide an overview of the thesis and act like an outline but not weigh down the reader with detailed information. Word will also update the List of Figures and List of Tables on command, as described for the Table of Contents.
[bookmark: _Toc155786308]ZOTERO AND OTHER CITATION-MANAGEMENT PROGRAMS
If you use reference-list generating software, such as Zotero, ensure that you fill in all fields completely and accurately when creating your citation list. Most citation styles now contain Zotero examples embedded in the citation guide. If you follow those examples, you should expect a correct output. If you do not, you must edit the reference list for punctuation formatting, and missing information once the footnotes (if you use Chicago footnote style) and List of References are imported. To edit most lists manually, you must remove the field code. Do this by pressing Shift + Control + F9 (or Control + 6) at the same time. In Word’s citation manager, click anywhere on the list and choose “Convert to static text.” If problems arise, consult a thesis processor for help.
The library offers citation management tools here.

[bookmark: _CROSS_REFERENCING][bookmark: _Toc155786309]CROSS REFERENCINGReferring to the wrong figure/table number is a top error found in reviews!

You must mention each figure and table by label and number in your narrative. If you have many figures and tables, you might want Word to keep track of the figure and table numbers for you as you write and revise. Follow these steps to have Word insert cross references for you: 
1. First, remove the period and tab from the Figure Title and Table Title styles (Styles pane > right click on style name > modify > format > numbering > define new number format >remove the period). 
To insert a cross reference, in the References tab, click Cross-reference. Choose Numbered item under “reference type” and Paragraph number under “insert reference to.” 
To update the cross references as you work, select all text (Control + A) and press F9. Follow prompts to update all linked content.
When you are sure all figures and tables are in their permanent positions, highlight all body text starting from page 1 and press Shift + Control + F9 or Control + 6. This breaks the field code from the cross references. 
Finally, reinsert the period and tab in the Figure Title and Table Title styles.
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Content that cannot be inserted directly into the thesis file should accompany the thesis as a supplemental file. (Note that we do allow paper sizes larger than 8 x 11 in the appendices inside the thesis, so a supplemental may not be needed, if you need only a larger page size.)
Your supplemental material can include PDF files, spreadsheets, audio/video/images, software or other electronic files, or a physical object such as map or CD/DVD. Links to these items will display alongside your thesis in the NPS Archive, Calhoun. 
Learn how and where to upload your supplemental files on our 
Thesis Supplementals page. Classified supplementals are processed separately, following the classified process.
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Appendix titles are also styled as Heading 1, minus a roman numeral—backspace to remove the roman numeral. Then, type “Appendix,” a letter, two spaces, and a title: “APPENDIX A.  DATA.” However, if you have only one appendix, do not add the letter “A.”
If you apply Heading 2 style in your appendices, and the lettering does not begin with “A,” right-click on the first Heading 2 of the appendix, and choose Restart at A.
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Apply Reference List style to your list of references to re-create or retain the formatting of this page. Remove manual line spaces that you have entered between entries, as the style comes with the proper spacing. 
A bibliography is uncommon in NPS theses; a list of references is the standard. A bibliography differs from a reference list in that it also includes sources you consulted but did not cite. 
All in-text citations must have a matching entry in the List of References, with few exceptions; consult your citation style guide.
Use an established citation style such as Chicago, APA, AMS, etc. Made-up or hybrid styles will not be accepted. You are required to use a department-required or advisor-approved citation style. Guides to the most-common citation styles used at NPS are available here: Citation guides. 
Again, if you use reference-list generating software, such as Zotero, ensure that you fill in all fields completely and accurately when creating your citation list. You must edit references for punctuation and formatting after importing them. If you follow the examples within the NPS Citation Guide, your output will be fabulous.
To edit most lists, you must remove the field code. Do this by highlighting all entries and pressing Shift + Control + F9 or Control + 6 at the same time. In Word’s citation manager, this is achieved by clicking on the list and choosing “convert to static text.”
Here are a few example entries:
Hawks, Mathew A. “Graph-Theoretic Statistical Methods for Detecting and Localizing Distributional Change in Multivariate Data,” Ph.D. diss., Naval Postgraduate School, 2015. (Chicago N-B style)
Naval Postgraduate School. (2017). Thesis_template_times [Word template]. https://my.nps.edu/documents/105790666/106471216/Thesis_Template_Times.docx (APA style)
[1]	B. Orend, Morality of War, 2nd ed. Tonawanda, NY, USA: Broadview Press, 2013. (IEEE style)
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Include your desired recipients in the Send My Thesis To section of your Python Thesis Dashboard.
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